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Results of Teacher Technology Survey 
By: Carole Colburn 

 
 Earlier this month, I sent out a technology survey to all district teachers asking seven 
questions with regard to proficiency in using various types of technology. Below, you will find 
the results of this survey in chart form. The question asked is at the top of each chart. A total of 
237 teachers responded (over 50% of all teachers) and I think this is a great representation. I will 
use this information to plan for future training opportunities. It is nice to see that so many of you 
have taken some training and are willing to attend more training when offered.  
 The two charts below the survey represent the number of people who have taken some 
type of technology training from September 2001 through December 5, 2002 and the number of 
times there have been training opportunities in each building for the same time period.  
 

1. How effective are you at using a computer?
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2. How would you rate your proficiency in using a 
computer to perform tasks necessary as a teacher 

(grading, attendance, e-mail, etc.?)
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3. Do you design lessons for your students that 
involve technology?
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4. Are you proficient in  using the Internet?
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5. Are you proficient in using Power Point in your 
lessons?
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6. Have you participated in any district sponsored 
training?
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7. Would you take more training if it was offered?
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Additional Training Information 

 
 
 

Number of People in "Seats"

0

50

100

150

200

250

H
igh School/

Freshm
an C

am
pus

M
cPherson/Three

Fires

H
ighlander W

ay

Voyager

C
hallenger

Latson

N
orthw

est

Southw
est

Southeast

C
om

m
unity

Education

Board of Education

Adm
inistration

M
isc. Staff

 
 
 

This chart represents the number of people who have attended a scheduled “training 
session” from September 2001 through December 5, 2002. This does not include the 
number of people who have had one-on-one help or follow-up help sessions for T4.  



   

   
  

 

Number of Training Opportunities
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This chart represents the number of training opportunities at each building from last 
year from September 2001 through December 5th, 2002. This includes sessions on the 
following topics: 
Integrade Pro (Electronic Grade book, Grade Reporting) 
Class XP (Attendance) 
ABACUS (Curriculum Management) 
Outlook (E-Mail, Calendar, Tasks)  
Internet 
Digital Camera Use 
Photo Editing 
Laptop Use 
Scanner Use 
Word (Labels, Tables, Templates, Tabs) 
Power Point (Slide Show, Jeopardy Board)  
Excel (Formulas, Spreadsheets, Charts) 
Publisher (Newsletters, Brochures) 
Inspiration (Concept Mapping) 
 
In addition, 80 teachers have been through T4: Tomorrow’s Technology/Today’s 
Teachers (a four-day long technology integration workshop developed specifically for 
HPS teachers.)  
 
Another 15 teachers have trained in Teach For Tomorrow (Michigan Merit)  
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FYI: We have a new person in the technology department. His name is Chris 
Janzer and he is our new Data Systems Analyst and Support person. (Read that: 
SASI data and support person.) Chris comes to us from Western Michigan 
University with a Bachelor’s Degree in Business Administration with a major in 
Computer Information Systems.  More on Chris in next month’s Tech Times, but 
for now, you can reach him to say hello and “welcome” or for questions by 
sending him an e-mail at janzerc@howellschools.com 
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Lesson Plan of the Month 

The following lesson plan comes from: MAISA and the REMC Association of 
Michigan 
Best Practices in Technology Integration Plan http://www.bestpractices.cc/ 
 
Submitted By: 
Name: Kelly Knight, Julie Lint, Steve Schnack, Christel Schaar, Dennis Schaar, 
Bruce Graves, Chris Villeneuve, Mark Olmstead, Todd Neibauer 
School District: Kingsley Area Schools 
School: Kingsley High School 
Address: 403 Blair Street, Kingsley, Michigan 49649 
 
Interstellar Travel Magazine 1 
Title: Interstellar Travel Magazine 
Subject(s): English, Social Studies, General Science, Algebra I, Pre-Algebra, 
Proficiency Math, Geometry, Careers, and Computer Literacy 
Intended Grade Level(s): 9th Grade 
 
Description: 
The project was an integrated academic assignment involving the four core classes of 
the freshman curriculum, including computer literacy and career classes. After choosing 
a planet other than Earth, each student designed and produced a 24-page travel 
magazine persuading the public to visit their planet. The magazine included individual 
assignments from each of their academic classes. The academic assignments met the 
curriculum benchmarks from the Michigan Curriculum Framework. The students were 
required to do research about their planet. They compared and contrasted their planet 
to Earth, developed a governmental system, graphed population growth, made a 

mailto:janzerc@howellschools.com
http://www.bestpractices.cc/


   

   
  

distance chart, wrote a prospective job-base article, and created an historical event 
reflecting an actual historical event from the United States. To meet the page 
requirement, students chose from a bank of assignments adding to the mandatory 
material. Class time was set-aside in each class to work on the magazine, but the 
majority of the assignment completed outside of the classroom. A folder and a computer 
disk were supplied at the beginning of the project for the storage of students’ research 
material. On the due date, the front and back magazine covers were laminated and the 
entire magazine was bound before being submitted. 
 
Curriculum Benchmarks: 
MI.SOC.I.3.HS.2 
Challenge arguments of historical inevitability by formulating examples of how different 
choices could have led to different consequences. 
MI.MAT.III.1.HS.4 
Identify what data are needed to answer a particular question or solve a given problem, 
and design and implement strategies to obtain, organize and present those data. 
 
Materials/Hardware/Software: 
Folders 
Magazines 
Calculators 
Graph Paper 
Computer Disk 
Internet Access 
Word Processing Software Package 
Puzzle Maker Software Package 
Spreadsheet Software Package 
Print Shop (or similar) software package 
 
Activities/Procedures: 
On the first day of the project, each teacher reviewed the project sheet and discussed 
the expectations of their component to the overall magazine. The English teacher 
supplied a folder and computer disk along with the project sheet requirements. The 
grading procedure was explained and students were advised they would be issued an 
individual grade as well as an overall grade for each of the core academic classes. The 
students were also urged to integrate the assignments for their classes as much as 
possible. The actual research on the planets was conducted in the general science 
class. A small percentage of class time in each core class was set aside to work on the 
magazine on a daily basis. The teachers stressed that the majority of this project 
needed to be completed outside of class. 
 
Assessment/Evaluation: 
Students were given credit in each of their classes for the individual assignments. When 
the final product was submitted, all the teachers met and evaluated all the magazines. 
Each student was given an overall grade in each of his or her classes for the final 
project. The point value for the overall project was different in each individual class. The 
reasoning behind this was to give each teacher, flexibility in determining the weight of 
the project. 
 



   

   
  

Follow-up Activities: 
The magazines were displayed for the public during the spring parent-teacher 
conferences. A reflective essay was assigned in the English class focusing on what the 
students learned, problems they encountered, what connections did they see between 
their classes, and what would they do differently next time. 

***If you have a technology-rich lesson that you would like to share with others, please 
send it to colburnc@howellschools.com no later than the last Monday of the month.  
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 Carole’s Training Corner  
Happy Holidays everyone! The time is going so fast that it is hard to believe we are already at the end of 
2002! It seems like just yesterday we were all talking about the Y2K bug. Hmmm…that will be in a trivia 
game in about 30 years, now won’t it?  

During November and December, I have been making the rounds to each elementary building, trying to 
catch folks who do not yet have an ABACUS account and offering training in this program. ABACUS is 
the curriculum management piece to the SASI program that contains district lesson plans that are tied to 
state standards and benchmarks. I am also working with both teachers and support staff at each building 
offering classes in Word. These classes are specific to certain features in Word like “Creating Tables and 
Templates,” or “Using Tabs and Mail Merge” in this program. If you are interested in me coming to your 
building for such training (in word or any application) please do not hesitate to send me an e-mail 
message and I will set something up that is convenient for you and others who would attend such a 
training.  

 Continue to check out my website for training updates: http://www.howellschools.com/~training 

Remember to keep smiling ~Carole ☺ 
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Tips & Tricks  
The following Tips & Tricks come from: www.wordtipsgold@vitalnews.com/ You can 
have these tips e-mailed to you directly each day by signing up at the above 
mentioned site. 

 
COMPARING DOCUMENT VERSIONS 
 
Word includes a tool that allows you to compare two documents to each other. The 
document in memory is marked with revision marks to indicate the changes from the 
document on disk. The way you compare documents depends on the version of Word 
you are using. Follow these steps for Word 2000: 
 
    

1. Load the newer version of the document into Word. 
2. Choose Track Changes from the Tools menu. Word displays a submenu. 
3. Choose the Compare Documents option. You are prompted for a filename to use 

for the comparison. 
4. Select the file to which you want to compare the document. 
5. Click on OK. 

 
**
 
******************************************************************** 

INSERTING TODAY'S DATE 
 
Many types of documents require the date. You may be working with a memo, a letter, a 
report, or some other document in which you must put the date. Word makes this easy 
by using the Date and Time option from the Insert menu. To insert the date, follow these 
steps: 
 

1. Position the insertion point where you want the date to appear. 
2. Choose Date and Time from the Insert menu. You will see the Date      and Time 

dialog box. 
3. Select a format for the date. 
4. Click on OK. 

 
If you choose the "Update Automatically" check box a the bottom of the dialog box, the 
date is inserted as a field and it will always be updated to reflect the current date as you 
work on the document on future days. This can be very helpful if you are working with a 
letter template that you want to always be "in sync" with the day you write the letter. 
 
********************************************************************** 

   
  



   

   
  

 
SELECTING A GRAPHIC THAT IS BEHIND TEXT 
 
When you add graphics to your document, Word allows you to arrange the graphics so 
they are behind the text. In other words, the text appears in front of the graphic. If you 
later need to make changes to the graphic in some way, you may not know exactly how 
to select it when it is obscured by the text in your document. 
 
If the graphic is not fully covered by text--perhaps there is a small corner of the graphic 
sticking out from behind the text--then you can select the graphic by simply clicking on 
the portion that is not covered by text. However, the easiest way to select a graphic--
even if it is behind text--is to follow these steps: 
 
   1. Make sure the Drawing toolbar is visible. (Click on the Drawing        button on the 

Standard toolbar, or choose View/Toolbars/Drawing.) 
   2. Click on the Select Objects tool on the Drawing toolbar. This tool looks like a mouse 

pointer that points up and to the left. 
      It is normally the second tool from the left on the Drawing      toolbar. 
   3. Click on the graphic you want to select, without regard to any      text that may be 

covering it. 
 
When you are done working with your graphics, make sure you click on the Select 
Objects tools again (to turn it off), or press Escape. You must turn off the Select Objects 
tool; otherwise you won't be able to edit any of the text in your document. 
 
********************************************************************** 
 
GETTING RID OF SPREADSHEET PANES IN EXCEL 
 
If you have previously divided your spreadsheet window into panes, you may at some 
point want to get rid of the panes. The easiest way to get rid of the panes is to simply 
double-click on the divider bar you want to remove. You can also get rid of panes by 
choosing the Remove Split option from the Window menu. 
 
********************************************************************* 
 
CHANGING FONT COLOR IN EXCEL 
 
Normally, Excel displays information using black type. This is acceptable if you are 
printing to a regular printer, but many people these days have color printers. 
Additionally, you may want to simply use different colors for displaying information on 
the screen. You can change the font color used by Excel in the following manner: 
 
   1. Choose the cells whose font color you wish to change. 
   2. Choose Cells from the Format menu. Excel displays the Format 
      Cells dialog box. 
   3. Make sure the Font tab is selected. 
   4. Using the Color drop-down list, select the color you want used for the information in 

the cells you selected in step 1. 
   5. Click on OK. 
 



   

   
  

There is another way to change font color, and you might find it a bit faster. You can 
change font color using the toolbars in this manner. 
 
   1. Choose the cells whose font color you wish to change. 
   2. Click on the down-arrow at the right side of the Font Color tool on the toolbar. This 

displays a color palette. 
   3. Click on the color you wish to use. 
 
At this point the color of the information in the selected cell is changed. You may also 
have noticed that the color bar at the bottom of the Font Color tool changed, as well. 
This means that in the future, all you need to do is select cells and click on the tool to 
change their font to the same color. 
 
 
********************************************************************** 
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Great “Holiday Projects” Links For You to Try…     

 http://www.craftfreebies.com/Christmas.html 

 http://crafterscommunity.com/ 

 http://www.make-stuff.com/hollidays/christmas.html 

 http://rats2u.com/christmas/christmas_crafts.htm 

 http://www.essortment.com/in/Crafts.Holiday/ 
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For suggestions or questions regarding TECH TIMES, contact: colburnc@howellschools.com 
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